
RELEASE NOTES

Release Notes for Nuke and Hiero
10.5v8

Release Date
21 September 2018

Qualified Operating Systems
• Mac OS X Mavericks (10.9) or Yosemite (10.10)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5
(running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When
enabled in the preferences, GPU processing is shared between the available GPUs for extra
processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 MacBook Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for
full functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 352907 - Write: You can now specify which channel is written first in multi-channel .exr files
using the first part dropdown in the Write node's Properties panel. All subsequent channels are
written in alphanumeric order.

Bug Fixes
There are no bug fixes in this release.

Release Notes for Nuke and Hiero 10.5v8 | New Features

http://www.nvidia.com/drivers


RELEASE NOTES
3

Known Issues and Workarounds
This section covers known issues and gives workarounds for them, where appropriate.

Known Issues Specific to Nuke 10.5
• Some links to the developer documentation are not working as expected. Please use the local copy
of the documentation included in the installer where possible:

<install location>/Nuke10.5v8/Documentation/

Known Issues Specific to Nuke Studio and Hiero 10.5
• BUG ID 239672 - Linux only: Reading files from NTFS disks/partitions can be extremely slow,
particularly for large files. This is a limitation of Linux NTFS file systems, rather than Foundry
products.

We recommend avoiding timeline playback that relies on source footage from NTFS
disks/partitions.

• BUG ID 235327 - Linux only: CPU usage can reach 100% on a single thread during flipbooking,
causing Nuke to become unresponsive.

• BUG ID 230536 - Soft Effects: The Burn-in effect does not maintain a constant text baseline for all
characters when the format is changed.

Other Known Issues

Known Issues Specific to Nuke

AudioRead

• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled
between file and custom.

• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.

• BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified.

• BUG ID 18451 - Flipbooking doesn't honor the time range knob.

• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.

• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves
correctly.
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BlinkScript/CUDA

• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA
error when the OS wakes up from sleep mode.

As a workaround, close and reopen Nuke to reactivate the CUDA drivers.

CameraTracker

• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez
modes.

• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image
in reference thumbnails, rather than just the RGB values.

Deep

• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.

As a workaround, preview the .exr in the file browser before reading it into Nuke.

Dope Sheet

• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you
execute Analyze Sequence with the Dope Sheet open.

• BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.

• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from
the Dope Sheet.

• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames
when frame snap is enabled.

• BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.

• BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to
have a non-empty frame expression.

• BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.

• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented
once in the Dope Sheet.

EditGeo

• BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on
geometry with animation baked into its vertices.
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To update the transform handle, toggle the axis alignment control between object and average
normal.

• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to
ignore the EditGeo node.

• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe
marker.

• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and
corner vertices.

Flipbook

• BUG ID 201156 - Nuke's flipbook defaults to the Write node's colorspace, which can result in
different output when compared to the Viewer.

As a workaround, either flipbook the node upstream of the Write node, or enable Burn in the LUT
in the Flipbook dialog.

• BUG ID 47005 - In the Flipbook Viewer, clicking the Go to start button always goes to frame 0, even
if the clip doesn't start at 0.

• BUG ID 47005 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both
rec709 and rec1886.

GPU

• BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.

Import Nuke

• BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command-line
arguments unavailable.

As a workaround, preserve sys.argv in another variable before you import Nuke.

• BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other
applications.

• BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is
available.

Linux Only

• BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%,
causing Nuke to become unresponsive.
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• BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.

As a workaround, launch Nuke from the command-line using:

LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0

• BUG ID 42581 - Keyboard Shortcuts: Using Ctrl+C to quit Nuke from the command-line when a
dialog box is open displays an error.

• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

Mac OS X Only

• Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA
CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers
directly from NVIDIA here:

http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html.

• BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the
Terminal.

• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.

• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when
you click Save Report.

• BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than
one instance of Nuke at the same time, can cause display corruption and/or entire system freezes.
This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT
650M.

As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU
acceleration in one instance of Nuke at a time.

• BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure
X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11
installed by default.

For more information, see http://support.apple.com/kb/HT5293.

• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.

As a workaround, either:

• tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or
Samba, depending on source), or

• using the command-line, copy the installation from Mac OS X to the network location using the
same file system as the destination.

• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.
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As a workaround, adjust the Viewer gain control to refresh the Viewer.

• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script,
except when Nuke is run from the command-line.

• BUG ID 13638 - The following graphics cards are not currently supported for Mac:

• ATI Radeon X1600

• ATI Radeon X1900

Users with these cards are able to render from the command-line, but in GUI sessions, the Node
Graph renders incorrectly due to a requirement of OpenGL 2 drivers.

• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.

• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder

• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.

• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry
through a ScanlineRender node causes Nuke to crash.

Monitor Out

• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.

• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO

• BUG ID 216806 - The public DD::Image interface for the OCIOColorSpace node can not initialize
certain values, and occasionally causes Nuke to crash.

Particles

• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to
geometry, does not render all frames to the .nkpc file.

• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is
out-of-date errors for negative frame numbers.

• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off
are not reliably cleared when rendering through ScanlineRender.

• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been
calculated within the particle system.

• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.
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• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.

• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind
the 3D grid lines.

Pixel Analyzer and Scopes

• BUG ID 44176 - PixelAnalyzer: The full frame samplingmode doesn't work immediately in the
timeline Viewer when the analyzer is initially added to the layout.

• BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the
Viewer bounding box to 1x1 for that frame.

• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.

• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include
viewer color transforms is enabled.

PrmanRender

• In the Nuke camera, the window roll control is not yet mapped to RenderMan.

• BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-
in the environment.plist file when in GUI mode.

See http://support.apple.com/kb/TS4267 for more information.

Python

• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes
Nuke to crash.

• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when
run from the command-line.

Run the script from Nuke's Script Editor to avoid this issue.

• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.

• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the
command-line.

To work around this issue, run the Python script from Nuke's Script Editor.

• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports
incorrect values.

As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are
currently selected in the Node Graph.
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• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first
created if it has an autolabel.

• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:

groupName.NodeName.knobname: unexpected 'k' in '0.knobname'

The problem is most likely that there is an expression using the input TCL command and doesn't
validate that there is an input connected. An example expression:

[input parent 0].translate.x

The input command returns 0 when it can't find the requested input, which generates an expression
of '0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the
value TCL command and specify a default value to return in the case that the expression is invalid. It
takes the form:

[value [input parent inputnumber].knob defaultValue]

Here is the modified example:

[value [input parent 0].translate.x 0]

The modified example returns 0 in the event that there is no input 0, and no longer results in an
error message.

• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>()
if the knob is called 'in'.

For example, this gives a syntax error:

nuke.nodes.Shuffle(in = 'depth')

while this works because 'in' is a string here and not a keyword:

sh = nuke.nodes.Shuffle()

sh['in'].setValue('depth')

RayRender

• BUG ID 230256 - Soft Shadows are not currently supported.

• BUG ID 197294 - Reflection occlusion is not currently supported.

• BUG ID 196980 - Clipped alpha shadows are not currently supported.

• BUG ID 196776 - Multiple bounce reflecton is not currently supported.

• BUG ID 196124 - RayRender does not currently support refraction.
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• BUG ID 195051 - The Wireframe shader node, located in 3D > Shader >Wireframe, is not
supported by RayRender.

• BUG ID 195004 - Custom lens shaders/projection modes are not currently supported.

• BUG ID 194819 - RayRender does not currently support Deep workflows.

• BUG ID 191108 - Particle sprites are not currently supported.

• BUG ID 174849 - The Displacement shader node, located in 3D > Shader, is not currently supported
by RayRender.

Read and Write

• BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in command-
line and GUI modes.

• BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.

• BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an
error decoding frame message in the Comp Viewer.

• BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the
rgba channels by default.

• BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.

• BUG ID 40684 - Rendering certain h264 encoded .mp4 files using themov32 encoder results in color
shifts using QuickTime 10.3 codecs.

• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to
ProRes 4444.

• BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes
correctly.

• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect
while toggling the read transform from file in combination with all objects and/or read on each
frame.

• BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a
superfluousmain view.

• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to
neighboring faces, leaving gaps in certain circumstances.

This issue is particularly visible when using the EditGeo node, which should not allow you to remove
faces from the geometry.

• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.

• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc
files.

As a workaround, ensure that ReadGeo > read on each frame is enabled.
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• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new
views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add
new views.

• If you have trouble with FBX files, it may be because they were written with an older version of FBX.
If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these
problems, you can use the FBX converter on the Autodesk website. It converts between various
different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac
OS X, and Linux.

To download the FBX converter:

1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855.

2. Scroll down to FBX Converter and click on one of the links to start the download.

Render codecs

Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the
following:

• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec
instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better
performance.

• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or
above. You may need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.

• If you're using Avid Meridien, you should only write out in NTSC and PAL.

Roto/RotoPaint Open Splines

• BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the
feather handles in the Viewer.

• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.

As a workaround, select the shape and then manually change the Properties view control to include
both views.

• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.

• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative
feather values.

• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave
erratically.

• BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects
in the hull or feather.
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• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally
produces artifacts in the spline's hull.

• BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is
set to 0.

• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.

• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight
rendering glitches inside the hull.

• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width
changes greatly from one point to the next

• BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open
Spline and Bezier tools.

Other Roto/RotoPaint Bugs

• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint
color.

• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo
the keyframe creation.

• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame,
disappear when drag-selected.

As a workaround, select the shape in the curves list to re-display the points.

• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.

NOTE: This also applies to SplineWarp matrices.

• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent
shapes for a single smooth operation.

• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.

• BUG ID 26855 - The undo and redo buttons in the Properties panel didn’t work as expected and
have been disabled.

The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the
Editmenu instead.

• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another
frame.

• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.

• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of
the screen.
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• The foreground onion skin overlay updates as you paint, rather than only updating with the new
stroke on pen up.

• It is not currently possible to clone RotoPaint nodes.

• Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled
on the layer you are working in.

ScanlineRender

• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.

• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in
semi transparent areas.

• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an
image.

SmartVector Toolset

• BUG ID 196455 - Rendering vectors after correcting the file control in the SmartVector node
occasionally displays a spurious No such file or directory error.

As a workaround, scrub to a different frame to remove the message.

• BUG ID 175605 - Entering a partial file path in the SmartVector file control and then clicking the file
browser icon does not open the file browser.

As a workaround, click OK on the error message and then click the file browser icon again.

Text

• BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control
differently, producing inconsistent output.

• BUG ID 39556 - In text editmode, it is not currently possible to edit text attributes when the Viewer
overlay is disabled.

• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does
not work as expected.

As a workaround, expression link the translate x and y controls separately.

• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.

• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame
where the character no longer exists, results in the transformation being lost.

• BUG ID 39130 - Splitting themessage field does not work as expected.

• BUG ID 38789 - Viewer toolbar controls steal cursor focus.
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• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.

• BUG ID 36372 - Selecting a TCL expression in themessage field doesn't always select the result in
the Viewer.

Tracker

• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back
the tracked frames.

As a workaround, you can enable full frame processing, though this may increase render times.

• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the
tracking anchor coordinates to 0,0.

• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.

• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.

• BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between
frames.

• BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn’t always update the available
Link to > Tracker linkingdialog or Tracker options.

As a workaround, close and re-open the Roto/RotoPaint properties panel to update the Link to
menu.

• BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected.

As a workaround, keyframe patterns should, where possible, be of comparable sizes.

Warpers

• BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display
an overlay until pen-up.

• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points
to 0,0, which cannot be undone.

• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are
removed.

• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot
currently be undone.

• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to
a new layer.

• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.
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• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to
display the cropped image and the black area between the crop box and the format when merged
over a background.

• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid
lines.

• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect inmorph mode, whenmix is set
at an intermediate value.

• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes
rendering problems.

• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when inmorph mode
withmix set at an intermediate value.

• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather
than just the latest, and the keyframes remain on the timeline and in the properties.

• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.

• BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add
Correspondence Point tool.

• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes,
even if a grid is not visible in the Viewer.

• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different
positions, does not undo as expected.

• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or
Dope Sheet.

• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new
grid using the Draw Boundary Viewer button.

• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A
shortcut.

• BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of
the Viewer, particularly when the grid is subdivided.

• BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as default when you split
controls into separate views.

Windows Only

• Nuke Non-commercial: Navigating to Help > License, clicking Deactivate or Deauthorize, and then
clicking Quit, causes Nuke Non-commercial to crash on exit.

As a workaround, change themode a few times until it work as expected.

• BUG ID 198430 - Nuke cannot read DNxHD .mxf files that have spaces in the file name.
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• BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you
have a previously saved FileChooser_Favorites.pref file in your ~/.nuke directory.

As a workaround, move or rename the FileChooser_Favorites.pref file, and re-launch Nuke.

• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you
use the erase end of the pen.

• BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422
(2vuy) pixel format due to a bug in the codec, resulting in solid green frames.

As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.

• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node,
such as Primatte or Shuffle, even after the node is removed from the Node Graph.

• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous

• BUG ID 226394 - Preferences: There are currently duplicate Script Editor controls under Other in
the Preferences dialog.

• BUG ID 169458 - Compositing Viewer: Setting the gamma control to 0 with Panels > Viewer (Comp)
> use GPU for Viewer when possible enabled in the preferences, renders the alpha channel black.

• BUG ID 49803 - AJA Monitor Output: Setting the NUKE_AJA_CHANNEL environment variable to 4
when the NUKE_AJA_DUALOUTPUT environment variable is set, streams the output to SDI3, rather
than SDI4.

• BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the Ranges tab and then
changing a value, such as Gain, causes Nuke to crash.

• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is
changed.

• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system
occasionally allows particles to pass through the bounce surface.

• BUG ID 42339 - TheModo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D
control type) does not work as expected.

• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel
doesn't work as expected.

• BUG ID 42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion,
perform poorly when they are downstream of nodes using PlanarIop, such as Denoise.

• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.

• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the
same name as the file path to the original.

Release Notes for Nuke and Hiero 10.5v8 | Known Issues andWorkarounds



RELEASE NOTES
17

WARNING: If you save this empty script when the network drive is reconnected, the original
is overwritten.

• BUG ID 41122 - MatchGrade:Match Different Clipmode does not allow you to set keyframes on
the Target for .mov clips with a frame range offset.

• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous
versions.

• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-
mouse button, pastes values into the control.

• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the
Nuke<>Mari bridge won't work unless all instances of Project3D are renamed appropriately in the
mari_bridge.py file.

• BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.

• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the
nodes from the Node Graph.

• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.

• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format
sizes causes corruption and constant refreshing in the Viewer.

• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.

• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the
script, resulting in error when the path doesn't exist:

Flipbook render failed: viewerCaptureOp: Cannot write to specified path

• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the
captured images.

• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when
mousing over the Viewer.

• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.

• BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when
render is set to off.

• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and
Hiero.

• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output
layer produces corrupt output.

As a workaround, shuffle the depth information to an alternate layer.

• BUG ID 32118 - Card3D: Whenmotionblur is enabled in the properties, FrameHold and TimeOffset
nodes are ignored when connected to the cam or axis inputs.
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• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual
bounding boxes for polymesh primitives.

• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.

• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier,
causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels
dropdown affect the frame hash.

• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.

NOTE: This known issue only applies to Roto and SplineWarp keys.

• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the
node is copy/pasted in the Node Graph.

• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.

• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a
Scene node only displays the animated Camera in the Viewer. There should be two cameras: one
static and one animated.

• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal
length of the new camera does not match that of the Viewer camera.

• BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no
longer available.

• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel
open.

• BUG ID 20204 - Multitexturing: When Preferences > Viewers >Multiframe is enabled, increasing
downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer.

You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.

• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the
Viewer.

• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.

• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because
some large polygons are clipped by the front camera plane.

You can minimize this effect by increasing the geometry tessellation max parameter.

• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or
zooming.

• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and
points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and
the other in 3D mode, and you have the panel for the RotoPaint visible.
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• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit
per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for
the caching to work.

• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is
not restricted to, any nodes that have an analysis pass.

• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.

Nuke runs correctly from a network install on Windows without specifically installing the run-time
libraries, though we still recommend that you do so as there are still some minor problems without
them.

• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render.
This question is unnecessary as the result is an anaglyph image. Irrespective of what view you
choose, the flipbook output is the same.

• File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so
if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker
or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke
instead of NukeX.

• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.

• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node
when using Create Scene:

• Select the Camera that was created in the 3D view when using the Create Scene button.

• Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to
focus (using F) on the point cloud. The resulting tumble camera movement is likely to be jumpy.

• Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled
against an earlier version of Nuke.

Known Issues Specific to Nuke Studio and Hiero

Create Comp

• Multi-view, such as stereoscopic, is not supported for clip instances created using right-click Effects
> Create Comp.

• BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes
Nuke Studio to crash when the Text nodes are disabled.

• BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the
comp frame range compared to the annotations precomp frame range.

• BUG ID 41665 - There are currently no options to load or overwrite an existing script when you
select Create Comp.
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Exporting

• BUG ID 49024 - Enabling the Collate... options in the Export dialog when exporting ignores the
Media tab Output Resolution setting for the track above, and produces output with incorrect
formatting.

• BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when
imported into Final Cut Pro.

• BUG ID 46403 - Controls set in the Export dialog Content tab occasionally default to the values
from the Nuke Write Node Content preset.

Linux Only

• BUG ID 167058 - Linux only: PulseAudio (ALSA) can cause Nuke Studio to crash or impair playback.

As a workaround, you can stop the pulseaudio daemon:

1. Open /etc/pulse/client.conf

2. Set autospawn = no and daemon-binary to /bin/true. Ensure these lines are not
commented out.

3. Call ps -e | grep pulse to check the process is still running.

4. Call pulseaudio --kill

5. Call ps -e | grep pulse again to check the process has stopped.

• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio
on Linux is scheduled for a later release.

• BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes
Nuke Studio to crash.

As a workaround, ensure that you have the latest NVIDIA drivers installed, available from:

www.nvidia.com/Download/index.aspx?lang=en-us

Mac OS X Only

• BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and
earlier.

This is a codec issue rather than an application issue.

• BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to
a conflict with the combination for the umlaut symbol.

To work around this, press Umomentarily before Alt+U.
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OCIO

• BUG ID 219603 - Nuke Studio doesn't load the individual default LUT settings when using the OCIO
environment variable to declare a custom configuration file.

As a workaround, manually force the load by changing the color management setting from Nuke
to OCIO.

• BUG ID 198348 - Saving and closing a project that uses an OCIO config, and then relocating the Nuke
install path, causes a Could not load OpenColorIO config error on reload.

Preferences

• The Preferences > Path substitution table for cross platform compatibility currently only comes
into effect at project load, not EDL/XML import.

As a workaround, import your sequence and set the Path substitution rule, then save the project
and reload to force the conversion.

Python API

• BUG ID 50113 - QActions are not added to the Editmenu in the menu bar when finding the menu
action by name.

As a workaround, use the objectName (foundry.menu.edit), where possible.

• BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.

Read and Write

• BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere .xml
files.

• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the
Rendering preference set to limit renderer.
As a workaround, you can change the preference Performance > Threads/Processes > Rendering
> export renders to no renderer limits to improve rendering speeds. You can also experiment
with the custom renderer limits to adjust performance on your machine.

• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.

• BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.

• BUG ID 36726 - Executing Clip > Rescan Clip Range displays frame read errors if the rescan adds
frames to the clip.
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• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to
other applications, such as Premiere or Resolve.

• BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default
Nuke layer, such as depth ormotion.

• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when
added to the timeline.

Soft Effects

• BUG ID 175574 - Soft Effects: Undo and redo of Properties panel changes can be unreliable if a soft
effect delete is in the same undo stack.

• BUG ID 50442 - TimeWarp: Applying a TimeWarp to a clip instance occasionally causes the
associated sequence bin item to display an error.

• BUG ID 50441 - TimeWarp: Applying a TimeWarp to clip instances retimed to values other than 100%
does not work as expected.

• BUG ID 49771 - Text/Burn-in: Nuke Studio doesn’t warn you if the font used in an effect could not be
found.

• BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between
sequences until the playhead is moved.

• BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the
examples provided here:

<install_directory>/pythonextensions/site-packages/hiero/examples/custom_
soft_effect.py

• BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying
metadata is updated.

As a workaround, either change the frame displayed in the Viewer or choose an alternate element
from the dropdown controls.

• BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the
timeline.

• BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above,
causes text rendering to fail during the transition.

• BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above,
causes the text size to reset.

• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression
writes incorrect frame numbers.

• BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the
Properties panel, if the node and effect names are identical.
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• BUG ID 42438 - Effects are only visible in the Viewer if there is a clip instance below them in the
timeline.

• BUG ID 42401 - Renaming a soft effect does not update the clip instance until you click in the
timeline.

• BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available
using the toolbar button on the timeline panel. The right-click Effectsmenu is currently disabled.

Timeline

• BUG ID 43913 - Locking a track currently prevents adding clip instances from the locked track to the
Viewer input buffers. You can still open clip instances in the various right-click Open In options and
access clip instance metadata.

• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below
existing tracks.

As a workaround, drag the clip to a new top-level track and then manually move the track to the
required position.

• BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the
right-click Open in Timeline option.

Windows Only

• BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size
depending on the timecode displayed.

• BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous

• BUG ID 200015 - Selecting multiple bin clips can cause the right-click menu to respond slowly.

• BUG ID 167919 - Localization: Re-importing clips into the Node Graph or project bin multiple times
retains the original localization policies settings.

• BUG ID 50490 - Audio: Zooming in on a waveform displays a Failed to decode audio error in the
timeline.

• BUG ID 50102 - Adding a custom Hiero window to a workspace and then saving it as the Nuke
default workspace causes Nuke to crash on start up.

• BUG ID 46235 - Comps with relative paths are not currently working when imported into the project.

• BUG ID 42462 - Cache pausing stops working if any change is made to the timeline.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes

There are no bug fixes in this release.
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Release Notes for Nuke and Hiero
10.5v7

Release Date
15 November 2017

Qualified Operating Systems
• Mac OS X Mavericks (10.9) or Yosemite (10.10)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5
(running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When
enabled in the preferences, GPU processing is shared between the available GPUs for extra
processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 MacBook Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for
full functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
There are no feature enhancements in this release.

Bug Fixes
• BUG ID 241846/267282 - Monitor Output: Selecting Full Resolution Stereomode in the Monitor
Output panel caused Nuke Studio to crash.
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• BUG ID 253321 - EXR: A customer .exr file did not display black frames outside the frame range
when a Reformat node was added downstream.

• BUG ID 316252/316253 - macOS/Linux only: Rendering with a fresh cache directory specified by the
NUKE_TEMP_DIR environment variable displayed errors in the first instance.

Monitor Output Only

NOTE: The fixes for these bugs rely on a version of the AJA monitor output driver that is not
yet available commercially. Please contact AJA Support for details of the correct driver
required for Linux distributions.

• BUG ID 229381 - AJA Io4K/IoXT cards were not discoverable with certain legacy drivers.

• BUG ID 251542/271817 - Selecting Full Resolution Stereomode in theMonitor Output panel
produced inconsistent results in the left and right views.

• BUG ID 253659 - Selecting Full Resolution Stereomode in theMonitor Output panel did not
output the correct color values.

• BUG ID 281752 - Selecting Full Resolution Stereomode in theMonitor Output panel occasionally
displayed a CNTV2Card: IOCTL_NTV2_AUTOCIRCULATE_CONTROL failed error.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes
• BUG ID 270405 - Python: Setting the MAGNITUDE flag using setFlag(0x00000001) on compatible
nodes, such as Constant, caused Nuke to crash.
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Release Notes for Nuke and Hiero
10.5v6

Release Date
21 September 2017

Qualified Operating Systems
• Mac OS X Mavericks (10.9) or Yosemite (10.10)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5
(running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When
enabled in the preferences, GPU processing is shared between the available GPUs for extra
processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 MacBook Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for
full functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
There are no feature enhancements in this release.

Bug Fixes
• BUG ID 137014 - DeepRead: Setting themissing frames control to black did not render any missing
frames black.
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• BUG ID 158689 - EXR: Setting the last frame after dropdown to black was ignored for certain .exr
files.

• BUG ID 182509 - Expressions: Linking two ColorLookupmaster curves caused images containing
negative values to display as nan (not a number) in the linked curve.

• BUG ID 218316 - ARRIRAW: The arriReader did not support the full range of integers (-12 to +12) for
the tint control.

• BUG ID 225493 - Windows only: Installing QuickTime 7.7.6, or earlier, removed certain .mov codecs
from the Write node's Properties panel.

• BUG ID 239752/270592 - ZDefocus: Rendering a script containing two or more ZDefocus nodes from
the command line caused Nuke to crash.

• BUG ID 246403 - Monitor Output: The Blackmagic Desktop Video Utility and Nuke Studio Monitor
Output panel did not always display the same data rate output.

• BUG ID 248914 - Composting Viewer: The Properties panel mask mode dropdown had no effect on
the Viewer.

• BUG ID 250718 - WriteGeo: The window scale uv values were ignored during export of .abc and
.fbx cameras.

• BUG ID 252765 - Export: Exporting an updated shot (light green) incorrectly displayed a dialog
asking you to re-render the shot.

• BUG ID 253647 - Monitor Output: 12-bit 4:4:4 output was incorrect for AJA Kona 3G cards.

• BUG ID 266338 - Audio: Playing audio backwards in a source Viewer caused the application to
become unresponsive and the audio to play forwards as normal.

• BUG ID 267027 - Monitor Output: Working in the linear colorspace caused the monitor to display
colors incorrectly until the colorspace was changed.

• BUG ID 267674 - BlinkScript: Default values could not be changed for float4x4matrix and float3x3
matrix in BlinkScript kernels.

• BUG ID 269361 - Monitor Output: 12-bit 4:4:4 output did not work as expected with a single BNC
cable for AJA Kona 3G cards.

• BUG ID 275703 - Monitor Output: Selecting the video legal range option did not limit output in 10-bit
mode for Blackmagic 4K Extreme 12G cards.

• BUG ID 278106 - Audio: Retiming and then slipping audio shots past the start of the shot caused
Nuke Studio to crash or rendered the waveform incorrectly.

• BUG ID 281177 - Monitor Output: Setting the LUT to none or custom in theMonitor Output panel
displayed artifacts in the monitor.

• BUG ID 281179 - Monitor Output: Switching to Full Resolution Stereo output during playback with
Blackmagic cards caused Nuke Studio to crash.

• BUG ID 283921 - Export: Transcoding Sony F5 - 5500K .mxf files to Apple ProRes 4444 .mov
displayed an error decoding frame error.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes
• BUG ID 270405 - Python: Setting the MAGNITUDE flag using setFlag(0x00000001) on compatible
nodes, such as Constant, caused Nuke to crash.
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Release Notes for Nuke and Hiero
10.5v5

Release Date
22 June 2017

Qualified Operating Systems
• Mac OS X 10.9 (Mavericks) or 10.10 (Yosemite)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 MacBook Pro 11,5
(running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When
enabled in the preferences, GPU processing is shared between the available GPUs for extra
processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 MacBook Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for
full functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 271330 - Monitor Output: A new preference, Panels > Viewer (Monitor Out) > use video
legal range for monitor out, has been added to automatically set Monitor Output to the legal video
range.
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Bug Fixes
• BUG ID 253309 - Export: Empty folders in the shot template were converted to file entries after
reloading a project.

• BUG ID 263073 - Soft Effects: A Text effect referencing clip and frame metadata on a different track
did not render correctly.

• BUG ID 263710 - Export: Importing frames from a sequence with sequences disabled, and then
creating and exporting a sequence from those frames, only rendered the first frame.

• BUG ID 281159 - Windows only: Rendering scripts containing two ZDefocus nodes from the
command line caused Nuke to crash.

Known Issues and Workarounds
This section covers known issues and gives workarounds for them, where appropriate.

Known Issues Specific to Nuke 10.5
• Some links to the developer documentation are not working as expected. Please use the local copy
of the documentation included in the installer where possible:

<install location>/Nuke10.5v5/Documentation/

• BUG ID 250107 - Monitor Output: 10-bit output from Blackmagic DeckLink HD Extreme 3D+ cards at
the extents of color ranges is incorrect.

As a workaround, using the Desktop Video Setup utility, ensure that the SDI Settings 4:4:4 RGB
checkbox is enabled and the SDI Configuration is set to Single Link.

Known Issues Specific to Nuke Studio and Hiero 10.5
• BUG ID 239672 - Linux only: Reading files from NTFS disks/partitions can be extremely slow,
particularly for large files. This is a limitation of Linux NTFS file systems, rather than Foundry
products.

We recommend avoiding timeline playback that relies on source footage from NTFS
disks/partitions.

• BUG ID 235327 - Linux only: CPU usage can reach 100% on a single thread during flipbooking,
causing Nuke to become unresponsive.

• BUG ID 230536 - Soft Effects: The Burn-in effect does not maintain a constant text baseline for all
characters when the format is changed.
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Other Known Issues

Known Issues Specific to Nuke

AudioRead

• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled
between file and custom.

• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.

• BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified.

• BUG ID 18451 - Flipbooking doesn't honor the time range knob.

• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.

• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves
correctly.

BlinkScript/CUDA

• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA
error when the OS wakes up from sleep mode.

As a workaround, close and reopen Nuke to reactivate the CUDA drivers.

CameraTracker

• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez
modes.

• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image
in reference thumbnails, rather than just the RGB values.

Deep

• BUG ID 43383 - Executing a script in command-line mode that reads in a deep image and then
writes it to disk, causes Nuke to crash.

As a workaround, run the script from the Script Editor inside Nuke.

• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.

As a workaround, preview the .exr in the file browser before reading it into Nuke.
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Dope Sheet

• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you
execute Analyze Sequence with the Dope Sheet open.

• BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.

• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from
the Dope Sheet.

• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames
when frame snap is enabled.

• BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.

• BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to
have a non-empty frame expression.

• BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.

• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented
once in the Dope Sheet.

EditGeo

• BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on
geometry with animation baked into its vertices.

To update the transform handle, toggle the axis alignment control between object and average
normal.

• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to
ignore the EditGeo node.

• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe
marker.

• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and
corner vertices.

Flipbook

• BUG ID 201156 - Nuke's flipbook defaults to the Write node's colorspace, which can result in
different output when compared to the Viewer.

As a workaround, either flipbook the node upstream of the Write node, or enable Burn in the LUT
in the Flipbook dialog.

• BUG ID 47005 - In the Flipbook Viewer, clicking the Go to start button always goes to frame 0, even
if the clip doesn't start at 0.
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• BUG ID 47005 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both
rec709 and rec1886.

GPU

• BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.

Import Nuke

• BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command-line
arguments unavailable.

As a workaround, preserve sys.argv in another variable before you import Nuke.

• BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other
applications.

• BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is
available.

Linux Only

• BUG ID 199990 - In some situations NVIDIA Quadro Linux drivers 319.23 can cause Nuke to hang
during start up.

As a workaround, update your drivers to 361.42.

• BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%,
causing Nuke to become unresponsive.

• BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.

As a workaround, launch Nuke from the command-line using:

LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0

• BUG ID 42581 - Keyboard Shortcuts: Using Ctrl+C to quit Nuke from the command-line when a
dialog box is open displays an error.

• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

Mac OS X Only

• Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA
CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers
directly from NVIDIA here:

http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html.
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• BUG ID 228076 - The PySide QtUiTools library is currently missing from the Nuke build.

• BUG ID 163543 - Mac OS X 10.11 only: Dragging handles in the 3D Comp Viewer can be slow to
respond.

• BUG ID 50371 - Script corruption can occasionally occur on Mac OS X 10.9 (Mavericks), and above,
when writing to SMB 2.1 and SMB 3 Sharepoint locations.

• BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the
Terminal.

• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.

• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when
you click Save Report.

• BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than
one instance of Nuke at the same time, can cause display corruption and/or entire system freezes.
This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT
650M.

As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU
acceleration in one instance of Nuke at a time.

• BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure
X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11
installed by default.

For more information, see http://support.apple.com/kb/HT5293.

• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.

As a workaround, either:

• tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or
Samba, depending on source), or

• using the command-line, copy the installation from Mac OS X to the network location using the
same file system as the destination.

• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.

As a workaround, adjust the Viewer gain control to refresh the Viewer.

• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script,
except when Nuke is run from the command-line.

• BUG ID 13638 - The following graphics cards are not currently supported for Mac:

• ATI Radeon X1600

• ATI Radeon X1900

Users with these cards are able to render from the command-line, but in GUI sessions, the Node
Graph renders incorrectly due to a requirement of OpenGL 2 drivers.
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• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.

• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder

• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.

• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry
through a ScanlineRender node causes Nuke to crash.

Monitor Out

• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.

• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO

• BUG ID 216806 - The public DD::Image interface for the OCIOColorSpace node can not initialize
certain values, and occasionally causes Nuke to crash.

• BUG ID 201193 - Read nodeMetadata tabs occasionally include irrelevant in and out colorspace
controls.

Particles

• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to
geometry, does not render all frames to the .nkpc file.

• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is
out-of-date errors for negative frame numbers.

• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off
are not reliably cleared when rendering through ScanlineRender.

• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been
calculated within the particle system.

• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.

• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.

• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind
the 3D grid lines.
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Pixel Analyzer and Scopes

• BUG ID 44176 - PixelAnalyzer: The full frame samplingmode doesn't work immediately in the
timeline Viewer when the analyzer is initially added to the layout.

• BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the
Viewer bounding box to 1x1 for that frame.

• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.

• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include
viewer color transforms is enabled.

PrmanRender

• In the Nuke camera, the window roll control is not yet mapped to RenderMan.

• BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-
in the environment.plist file when in GUI mode.

See http://support.apple.com/kb/TS4267 for more information.

Python

• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes
Nuke to crash.

• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when
run from the command-line.

Run the script from Nuke's Script Editor to avoid this issue.

• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.

• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the
command-line.

To work around this issue, run the Python script from Nuke's Script Editor.

• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports
incorrect values.

As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are
currently selected in the Node Graph.

• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first
created if it has an autolabel.

• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at
default (True)may crash when too many node control panels are created too quickly. The
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workaround is to pass the in-panel argument as False or else use nuke.nodes.NodeClass() (where
NodeClass is the type of node to create) to create the node and then connect it to the currently
selected node manually.

• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the
Script Editor as that can cause Nuke to crash. Instead, you can use the same command from your
menu.py, restore layouts by selecting Layout > Restore Layout, or use a custom menu or toolbar
item.

• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:

groupName.NodeName.knobname: unexpected 'k' in '0.knobname'

The problem is most likely that there is an expression using the input TCL command and doesn't
validate that there is an input connected. An example expression:

[input parent 0].translate.x

The input command returns 0 when it can't find the requested input, which generates an expression
of '0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the
value TCL command and specify a default value to return in the case that the expression is invalid. It
takes the form:

[value [input parent inputnumber].knob defaultValue]

Here is the modified example:

[value [input parent 0].translate.x 0]

The modified example returns 0 in the event that there is no input 0, and no longer results in an
error message.

• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>()
if the knob is called 'in'.

For example, this gives a syntax error:

nuke.nodes.Shuffle(in = 'depth')

while this works because 'in' is a string here and not a keyword:

sh = nuke.nodes.Shuffle()

sh['in'].setValue('depth')

RayRender

• BUG ID 230256 - Soft Shadows are not currently supported.
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• BUG ID 197294 - Reflection occlusion is not currently supported.

• BUG ID 196980 - Clipped alpha shadows are not currently supported.

• BUG ID 196776 - Multiple bounce reflecton is not currently supported.

• BUG ID 196124 - RayRender does not currently support refraction.

• BUG ID 195051 - The Wireframe shader node, located in 3D > Shader >Wireframe, is not
supported by RayRender.

• BUG ID 195004 - Custom lens shaders/projection modes are not currently supported.

• BUG ID 194819 - RayRender does not currently support Deep workflows.

• BUG ID 191108 - Particle sprites are not currently supported.

• BUG ID 174849 - The Displacement shader node, located in 3D > Shader, is not currently supported
by RayRender.

Read and Write

• BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in command-
line and GUI modes.

• BUG ID 48935 - MXF: Importing a certain JPEG2000 file causes Nuke to crash or display the file
incorrectly.

• BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.

• BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an
error decoding frame message in the Comp Viewer.

• BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the
rgba channels by default.

• BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.

• BUG ID 40684 - Rendering certain h264 encoded .mp4 files using themov32 encoder results in color
shifts using QuickTime 10.3 codecs.

• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to
ProRes 4444.

• BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes
correctly.

• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect
while toggling the read transform from file in combination with all objects and/or read on each
frame.

• BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a
superfluousmain view.

• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to
neighboring faces, leaving gaps in certain circumstances.

Release Notes for Nuke and Hiero 10.5v5 | Known Issues andWorkarounds



RELEASE NOTES
47

This issue is particularly visible when using the EditGeo node, which should not allow you to remove
faces from the geometry.

• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.

• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc
files.

As a workaround, ensure that ReadGeo > read on each frame is enabled.

• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new
views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add
new views.

• If you have trouble with FBX files, it may be because they were written with an older version of FBX.
If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these
problems, you can use the FBX converter on the Autodesk website. It converts between various
different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac
OS X, and Linux.

To download the FBX converter:

1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855.

2. Scroll down to FBX Converter and click on one of the links to start the download.

Render codecs

Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the
following:

• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec
instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better
performance.

• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or
above. You may need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.

• If you're using Avid Meridien, you should only write out in NTSC and PAL.

Roto/RotoPaint Open Splines

• BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the
feather handles in the Viewer.

• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.

As a workaround, select the shape and then manually change the Properties view control to include
both views.
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• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.

• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative
feather values.

• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave
erratically.

• BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects
in the hull or feather.

• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally
produces artifacts in the spline's hull.

• BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is
set to 0.

• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.

• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight
rendering glitches inside the hull.

• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width
changes greatly from one point to the next

• BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open
Spline and Bezier tools.

Other Roto/RotoPaint Bugs

• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint
color.

• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo
the keyframe creation.

• BUG ID 32450 - RotoPaint Stereo: Attempting to undo multiple split-control transforms on the same
shape reverts the shape to its original position.

• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame,
disappear when drag-selected.

As a workaround, select the shape in the curves list to re-display the points.

• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.

NOTE: This also applies to SplineWarp matrices.

• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent
shapes for a single smooth operation.

• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.
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• BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke
8, but bear in mind that they won’t be backwards compatible with Nuke 6 once converted, unless
you follow the instructions below:

Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:

• Click Save As to convert the script to the Nuke 8 Roto format, or

• Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if:

- You don't intend to make any changes, or

- You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.

If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or
convertDirectoryToNuke6 Python functions when running Nuke 8 in command-line only mode:

NOTE: The conversion functions cannot convert stereo-split curves as they are not
supported by Nuke 6.

• To convert individual .nk scripts:
convertToNuke6(fromScript, toScript, overwrite = False)

• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern =.*\.nk, overwrite =
False)

NOTE: The pattern is a regular expression.

An example single script conversion and rename to the same directory, from the command-line (or
Terminal):
$ <NukeInstallDir>/Nuke8.0v1 -t

>>> import nuke.rotopaint

>>> nuke.rotopaint.convertToNuke6(/tmp/myRoto8.nk, /tmp/myRoto6.nk)

• BUG ID 26855 - The undo and redo buttons in the Properties panel didn’t work as expected and
have been disabled.

The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the
Editmenu instead.

• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another
frame.

• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.

• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of
the screen.

• The foreground onion skin overlay updates as you paint, rather than only updating with the new
stroke on pen up.
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• It is not currently possible to clone RotoPaint nodes.

• Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled
on the layer you are working in.

ScanlineRender

• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.

• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in
semi transparent areas.

• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an
image.

SmartVector Toolset

• BUG ID 196455 - Rendering vectors after correcting the file control in the SmartVector node
occasionally displays a spurious No such file or directory error.

As a workaround, scrub to a different frame to remove the message.

• BUG ID 175605 - Entering a partial file path in the SmartVector file control and then clicking the file
browser icon does not open the file browser.

As a workaround, click OK on the error message and then click the file browser icon again.

Text

• BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control
differently, producing inconsistent output.

• BUG ID 39556 - In text editmode, it is not currently possible to edit text attributes when the Viewer
overlay is disabled.

• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does
not work as expected.

As a workaround, expression link the translate x and y controls separately.

• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.

• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame
where the character no longer exists, results in the transformation being lost.

• BUG ID 39130 - Splitting themessage field does not work as expected.

• BUG ID 38789 - Viewer toolbar controls steal cursor focus.

• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.
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• BUG ID 36372 - Selecting a TCL expression in themessage field doesn't always select the result in
the Viewer.

Tracker

• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back
the tracked frames.

As a workaround, you can enable full frame processing, though this may increase render times.

• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the
tracking anchor coordinates to 0,0.

• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.

• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.

• BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between
frames.

• BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn’t always update the available
Link to > Tracker linkingdialog or Tracker options.

As a workaround, close and re-open the Roto/RotoPaint properties panel to update the Link to
menu.

• BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected.

As a workaround, keyframe patterns should, where possible, be of comparable sizes.

Warpers

• BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display
an overlay until pen-up.

• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points
to 0,0, which cannot be undone.

• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are
removed.

• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot
currently be undone.

• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to
a new layer.

• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.

• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to
display the cropped image and the black area between the crop box and the format when merged
over a background.
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• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid
lines.

• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect inmorph mode, whenmix is set
at an intermediate value.

• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes
rendering problems.

• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when inmorph mode
withmix set at an intermediate value.

• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather
than just the latest, and the keyframes remain on the timeline and in the properties.

• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.

• BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add
Correspondence Point tool.

• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes,
even if a grid is not visible in the Viewer.

• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different
positions, does not undo as expected.

• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or
Dope Sheet.

• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new
grid using the Draw Boundary Viewer button.

• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A
shortcut.

• BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of
the Viewer, particularly when the grid is subdivided.

• BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as default when you split
controls into separate views.

Windows Only

• Nuke Non-commercial: Navigating to Help > License, clicking Deactivate or Deauthorize, and then
clicking Quit, causes Nuke Non-commercial to crash on exit.

As a workaround, change themode a few times until it work as expected.

• BUG ID 198430 - Nuke cannot read DNxHD .mxf files that have spaces in the file name.

• BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you
have a previously saved FileChooser_Favorites.pref file in your ~/.nuke directory.

As a workaround, move or rename the FileChooser_Favorites.pref file, and re-launch Nuke.
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• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you
use the erase end of the pen.

• BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422
(2vuy) pixel format due to a bug in the codec, resulting in solid green frames.

As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.

• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node,
such as Primatte or Shuffle, even after the node is removed from the Node Graph.

• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous

• BUG ID 228258 - Calling fromScript() on a knob that has not been added causes Nuke to crash.

• BUG ID 226394 - Preferences: There are currently duplicate Script Editor controls under Other in
the Preferences dialog.

• BUG ID 169458 - Compositing Viewer: Setting the gamma control to 0 with Panels > Viewer (Comp)
> use GPU for Viewer when possible enabled in the preferences, renders the alpha channel black.

• BUG ID 168350 - AMD GPUs are reported as ATI GPUs in the node properties and --gpulist on the
command line.

• BUG ID 50715 - ZDefocus: Switching the filter type to image causes Nuke to crash in a customer
script.

• BUG ID 49803 - AJA Monitor Output: Setting the NUKE_AJA_CHANNEL environment variable to 4
when the NUKE_AJA_DUALOUTPUT environment variable is set, streams the output to SDI3, rather
than SDI4.

• BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the Ranges tab and then
changing a value, such as Gain, causes Nuke to crash.

• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is
changed.

• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system
occasionally allows particles to pass through the bounce surface.

• BUG ID 42339 - TheModo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D
control type) does not work as expected.

• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel
doesn't work as expected.

• BUG ID 42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion,
perform poorly when they are downstream of nodes using PlanarIop, such as Denoise.

• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.

• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the
same name as the file path to the original.
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WARNING: If you save this empty script when the network drive is reconnected, the original
is overwritten.

• BUG ID 41122 - MatchGrade:Match Different Clipmode does not allow you to set keyframes on
the Target for .mov clips with a frame range offset.

• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous
versions.

• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-
mouse button, pastes values into the control.

• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the
Nuke<>Mari bridge won't work unless all instances of Project3D are renamed appropriately in the
mari_bridge.py file.

• BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.

• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the
nodes from the Node Graph.

• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.

• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format
sizes causes corruption and constant refreshing in the Viewer.

• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.

• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the
script, resulting in error when the path doesn't exist:

Flipbook render failed: viewerCaptureOp: Cannot write to specified path

• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the
captured images.

• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when
mousing over the Viewer.

• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.

• BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when
render is set to off.

• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and
Hiero.

• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output
layer produces corrupt output.

As a workaround, shuffle the depth information to an alternate layer.

• BUG ID 32118 - Card3D: Whenmotionblur is enabled in the properties, FrameHold and TimeOffset
nodes are ignored when connected to the cam or axis inputs.
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• BUG ID 31803 - Using Shift+drag on a control’s animation icon only copies the value for the current
frame, not the entire expression.

• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual
bounding boxes for polymesh primitives.

• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.

• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier,
causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels
dropdown affect the frame hash.

• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.

NOTE: This known issue only applies to Roto and SplineWarp keys.

• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the
node is copy/pasted in the Node Graph.

• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.

• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a
Scene node only displays the animated Camera in the Viewer. There should be two cameras: one
static and one animated.

• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal
length of the new camera does not match that of the Viewer camera.

• BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no
longer available.

• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel
open.

• BUG ID 20204 - Multitexturing: When Preferences > Viewers >Multiframe is enabled, increasing
downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer.

You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.

• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the
Viewer.

• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch
in the Properties panel.

• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.

• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because
some large polygons are clipped by the front camera plane.

You can minimize this effect by increasing the geometry tessellation max parameter.

• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or
zooming.
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• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and
points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and
the other in 3D mode, and you have the panel for the RotoPaint visible.

• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit
per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for
the caching to work.

• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is
not restricted to, any nodes that have an analysis pass.

• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.

Nuke runs correctly from a network install on Windows without specifically installing the run-time
libraries, though we still recommend that you do so as there are still some minor problems without
them.

• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render.
This question is unnecessary as the result is an anaglyph image. Irrespective of what view you
choose, the flipbook output is the same.

• File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so
if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker
or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke
instead of NukeX.

• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.

• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node
when using Create Scene:

• Select the Camera that was created in the 3D view when using the Create Scene button.

• Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to
focus (using F) on the point cloud. The resulting tumble camera movement is likely to be jumpy.

• Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled
against an earlier version of Nuke.

Known Issues Specific to Nuke Studio and Hiero

Create Comp

• Multi-view, such as stereoscopic, is not supported for clip instances created using right-click Effects
> Create Comp.

• BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes
Nuke Studio to crash when the Text nodes are disabled.

• BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the
comp frame range compared to the annotations precomp frame range.
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• BUG ID 41665 - There are currently no options to load or overwrite an existing script when you
select Create Comp.

Exporting

• BUG ID 49024 - Enabling the Collate... options in the Export dialog when exporting ignores the
Media tab Output Resolution setting for the track above, and produces output with incorrect
formatting.

• BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when
imported into Final Cut Pro.

• BUG ID 46403 - Controls set in the Export dialog Content tab occasionally default to the values
from the Nuke Write Node Content preset.

Linux Only

• BUG ID 167058 - Linux only: PulseAudio (ALSA) can cause Nuke Studio to crash or impair playback.

As a workaround, you can stop the pulseaudio daemon:

1. Open /etc/pulse/client.conf

2. Set autospawn = no and daemon-binary to /bin/true. Ensure these lines are not
commented out.

3. Call ps -e | grep pulse to check the process is still running.

4. Call pulseaudio --kill

5. Call ps -e | grep pulse again to check the process has stopped.

• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio
on Linux is scheduled for a later release.

• BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes
Nuke Studio to crash.

As a workaround, ensure that you have the latest NVIDIA drivers installed, available from:

www.nvidia.com/Download/index.aspx?lang=en-us

Mac OS X Only

• BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and
earlier.

This is a codec issue rather than an application issue.

• BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to
a conflict with the combination for the umlaut symbol.
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To work around this, press Umomentarily before Alt+U.

OCIO

• BUG ID 219603 - Nuke Studio doesn't load the individual default LUT settings when using the OCIO
environment variable to declare a custom configuration file.

As a workaround, manually force the load by changing the color management setting from Nuke
to OCIO.

• BUG ID 198348 - Saving and closing a project that uses an OCIO config, and then relocating the Nuke
install path, causes a Could not load OpenColorIO config error on reload.

Preferences

• The Preferences > Path substitution table for cross platform compatibility currently only comes
into effect at project load, not EDL/XML import.

As a workaround, import your sequence and set the Path substitution rule, then save the project
and reload to force the conversion.

Python API

• BUG ID 50113 - QActions are not added to the Editmenu in the menu bar when finding the menu
action by name.

As a workaround, use the objectName (foundry.menu.edit), where possible.

• BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.

Read and Write

• BUG ID 49912 - HieroPlayer: Projects created in version 1.9, or earlier, are not editable in
HieroPlayer 9.0.

• BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere .xml
files.

• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the
Rendering preference set to limit renderer.
As a workaround, you can change the preference Performance > Threads/Processes > Rendering
> export renders to no renderer limits to improve rendering speeds. You can also experiment
with the custom renderer limits to adjust performance on your machine.

• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.

• BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.
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• BUG ID 36726 - Executing Clip > Rescan Clip Range displays frame read errors if the rescan adds
frames to the clip.

• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to
other applications, such as Premiere or Resolve.

• BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default
Nuke layer, such as depth ormotion.

• BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25.

• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when
added to the timeline.

Soft Effects

• BUG ID 175574 - Soft Effects: Undo and redo of Properties panel changes can be unreliable if a soft
effect delete is in the same undo stack.

• BUG ID 50442 - TimeWarp: Applying a TimeWarp to a clip instance occasionally causes the
associated sequence bin item to display an error.

• BUG ID 50441 - TimeWarp: Applying a TimeWarp to clip instances retimed to values other than 100%
does not work as expected.

• BUG ID 49771 - Text/Burn-in: Nuke Studio doesn’t warn you if the font used in an effect could not be
found.

• BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between
sequences until the playhead is moved.

• BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the
examples provided here:

<install_directory>/pythonextensions/site-packages/hiero/examples/custom_
soft_effect.py

• BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying
metadata is updated.

As a workaround, either change the frame displayed in the Viewer or choose an alternate element
from the dropdown controls.

• BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the
timeline.

• BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above,
causes text rendering to fail during the transition.

• BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above,
causes the text size to reset.

• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression
writes incorrect frame numbers.
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• BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the
Properties panel, if the node and effect names are identical.

• BUG ID 42438 - Effects are only visible in the Viewer if there is a clip instance below them in the
timeline.

• BUG ID 42401 - Renaming a soft effect does not update the clip instance until you click in the
timeline.

• BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available
using the toolbar button on the timeline panel. The right-click Effectsmenu is currently disabled.

Timeline

• BUG ID 43913 - Locking a track currently prevents adding clip instances from the locked track to the
Viewer input buffers. You can still open clip instances in the various right-click Open In options and
access clip instance metadata.

• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below
existing tracks.

As a workaround, drag the clip to a new top-level track and then manually move the track to the
required position.

• BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the
right-click Open in Timeline option.

Windows Only

• BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size
depending on the timecode displayed.

• BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous

• BUG ID 200015 - Selecting multiple bin clips can cause the right-click menu to respond slowly.

• BUG ID 167919 - Localization: Re-importing clips into the Node Graph or project bin multiple times
retains the original localization policies settings.

• BUG ID 50490 - Audio: Zooming in on a waveform displays a Failed to decode audio error in the
timeline.

• BUG ID 50102 - Adding a custom Hiero window to a workspace and then saving it as the Nuke
default workspace causes Nuke to crash on start up.

• BUG ID 46235 - Comps with relative paths are not currently working when imported into the project.

• BUG ID 42462 - Cache pausing stops working if any change is made to the timeline.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes

There are no bug fixes in this release.
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Release Notes for Nuke and Hiero
10.5v4

Release Date
4 May 2017

Qualified Operating Systems
• Mac OS X 10.9 (Mavericks) or 10.10 (Yosemite)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5 (running
OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in
the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 Mac Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for full
functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
There are no feature enhancements in this release.

Bug Fixes
• BUG ID 132856 - OCIO CDLTransform: The read from file and cccid controls did not work as
expected.
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• BUG ID 148383 - Expressions: Holding Shift and then dragging the animation icon in a node's
Properties panel did not copy expressions correctly.

• BUG ID 154814 - Timeline: Importing multiple EDL tracks using New Track > New Track(s) from
EDL created the tracks in reverse order.

• BUG ID 164572 - DeepWrite: Leaving the file type control blank caused Nuke to crash.

• BUG ID 208545 - OCIO CDLTransform: CDLs with no ColorCorrection id value set caused Nuke to
become unresponsive.

• BUG ID 253481 - Export: Adding additional nodes to an export track did not work as expected.

• BUG ID 270344 - Switch: Disabling a Switch node did not pass the default input down the node tree.

• BUG ID 271332 - Monitor Output: Blackmagic Decklink Studio 2 cards distributed colors slightly
differently between the 8-bit and 10-bit modes.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes

There are no bug fixes in this release.
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Release Notes for Nuke and Hiero
10.5v3

Release Date
4 April 2017

Qualified Operating Systems
• Mac OS X 10.9 (Mavericks) or 10.10 (Yosemite)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5 (running
OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in
the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 Mac Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for full
functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 266967 - Monitor Output: A new use video legal range control has been added to the
compositing Viewer Properties panel. Enabling the checkbox transforms monitor output to the
legal video range.

Bug Fixes
• BUG ID 143352 - Denoise: Moving the analysis region outside the frame bounding box caused Nuke
to crash.

Release Notes for Nuke and Hiero 10.5v3 | New Features

http://www.nvidia.com/drivers


RELEASE NOTES
70

• BUG ID 163170 - Custom panels docked in the wrong pane when added using the button in the top-
left of the pane.

• BUG ID 240564 - Calling node dependencies() from the Script Editor sometimes failed with
expression-linked nodes.

• BUG ID 241829 - Create Comp: Retimed clip instances produced comps with a one-frame offset.

• BUG ID 242150/264672 - Timeline: The keyboard shortcuts to nudge a clip instance between tracks
(Alt+. and Alt+,) did not work as expected.

• BUG ID 249050 - PositionToPoints: Connecting a Viewer to a PositionToPoints node in a customer
script caused Nuke to crash.

• BUG ID 253488 - Export: Track names containing hyphens did not export correctly.

• BUG ID 266188 - Export: The Version token number control only allowed a two-digit maximum,
rather than the expected four digits.

Release Notes for Nuke and Hiero 10.5v3 | Bug Fixes



RELEASE NOTES
71

Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes

There are no bug fixes in this release.
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Release Notes for Nuke and Hiero
10.5v2

Release Date
17 February 2017

Qualified Operating Systems
• Mac OS X 10.9 (Mavericks) or 10.10 (Yosemite)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5 (running
OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in
the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 Mac Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for full
functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 233227 - Monitor Output: The AJA driver version has been updated to 12.x on all platforms.

Bug Fixes
• BUG ID 152981 - SplineWarp: Flipping a spline and moving some points corrupted the undo stack in
a customer script.

• BUG ID 159942 - Monitor Output: Switching between 8-bit and 10-bit output produced precision and
scaling inconsistencies.
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• BUG ID 161916 - Windows only: Reading some .mov files multiple times caused Nuke to become
unresponsive.

• BUG ID 163561 - Mac OS X only: Mousing over the compositing Viewer stopped it updating under El
Capitan (10.11).

• BUG ID 174710 - Audio: Moving In and Out points on the timeline produced audio scrubbing errors.

• BUG ID 183288/200196 - Mac OS X only: Moving the cursor over the Viewer or frame slider caused a
drop in frame rate under El Capitan (10.11).

• BUG ID 217352 - Roto/RotoPaint: Cusping and smoothing B-Spline points did not work as expected.

• BUG ID 217365 - Mac OS X only: Zooming using a Wacom tablet was unpredictable under El Capitan
(10.11).

• BUG ID 217906 - Mac OS X only: Entering / (forward slash) in Project Settings > Export > Project
Root corrupted the path mapping in the Export dialog.

• BUG ID 224244 - Write: The mov64 writer encoded DNxHD metadata incorrectly.

• BUG ID 224645 - Linux only: Disabling a Monitor Output audio device in the Preferences caused
Nuke to crash on playback.

• BUG ID 224801 - ScanlineRender/RayRender: Adding a FrameHold or TimeOffset node after a Scene
node disabled any lights within that scene.

• BUG ID 228369 - Monitor Output: The color range was incorrect for some inputs with video mode
enabled in Nuke Studio's Monitor Output controls.

• BUG ID 228388 - Monitor Output: The color range in 10-bit output was incorrect.

• BUG ID 232230 - Linux only: Monitor Output from AJA Kona 3G and Kona 4 cards produced audible
clicking during playback.

• BUG ID 232743 - Monitor Output: 10-bit output from Blackmagic 4K Extreme cards was incorrect.

• BUG ID 233213 - Mac OS X only: Kona 3G cards were not recognized under Yosemite (10.10.5) with
the latest AJA driver installed.

• BUG ID 235438 - Track Blending: Slipping a clip instance below a blended track displayed an input
color space index out of range warning in the Viewer.

• BUG ID 240120 - Write: The mov64 writer encoded DNxHD files as Video Range when Full Range
was specified in the Write Properties.

• BUG ID 241528 - Create Comp: Adding a Transform soft effect to a blended track occasionally
cropped the blended output incorrectly.

• BUG ID 241786 - Soft Effects: Keyframes were misplaced in exported .nk scripts when the timeline
contained negative retimes and dissolves.

• BUG ID 241833 - Monitor Out: 8-bit and 10-bit output was inconsistent between the compositing and
timeline Viewers for non-grayscale images.

• BUG ID 241908 - Linux only: Enabling Performance > Caching > clear timeline Viewer cache
when the application goes to the background in the Preferences, occasionally caused Nuke
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Studio to freeze when switching application if the playback cache contained a large amount of
frames.

• BUG ID 242147 - Monitor Out: Blackmagic cards produced inconsistent results for 8-bit output.

• BUG ID 243096 - Licensing: Hiero did not launch with a Nuke Studio license.

• BUG ID 244661 - Roto/RotoPaint: Pressing the cusp keyboard shortcut (Shift+Z) after a control point
has been cusped already caused the maximum step counter to overflow, resulting in more presses
to smooth (Z) the point to its original state.

• BUG ID 245442 - Export: Shot templates containing multiple Write nodes placed all Writes vertically
with overlapping connections in the resulting Nuke script.

• BUG ID 245458 - Linux only: The frame rate of .exr clip instances on the timeline was unreliable
during playback.

• BUG ID 246166 - Export: Batch export of comps occasionally didn't tag all the items correctly.

• BUG ID 246172 - The first frame of .avi clip instances was black until you scrubbed through the
timeline and then returned to the first frame.

• BUG ID 246933 - Timeline: The track height adjustment cursor was incorrect.

• BUG ID 246942 - Export: Certain clip instances were retimed incorrectly after export from the
timeline.

• BUG ID 248113/248294 - Monitor Output: Blackmagic DeckLink Mini cards produced flickering or
striped output on playback.

• BUG ID 248443 - Monitor Output: Blackmagic DeckLink Mini and 4K Extreme cards produced
incorrect color output.

• BUG ID 248497 - Monitor Output: 10-bit output from Blackmagic DeckLink 4K Extreme and AJA Kona
3G cards did not appear as expected in the Compositing environment.

• BUG ID 248755 - Monitor Output: 10-bit output from Blackmagic DeckLink 4K Extreme cards
produced gray spots in the Compositing environment.

• BUG ID 249380 - Export: Process as Shots using the Basic Nuke Shot preset occasionally didn't tag
all shots correctly.

• BUG ID 249433 - Curve Editor: Deleting a keyframe and then undoing the action didn't work as
expected.

• BUG ID 249763 - Export: Metadata was written incorrectly when exports contained negative retimes.

• BUG ID 249921 - Monitor Output: Blackmagic DeckLink 4K Extreme output from the Compositing
environment caused Nuke to become unresponsive after a few minutes.

• BUG ID 250041 - Monitor Output: Output was incorrect on the monitor for images containing color
outside the 0-1 range in the Timeline environment.

• BUG ID 250180 - Export: Tags were not added to clips after export and Build Track > From Export
Tag was disabled.
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• BUG ID 250510 - Create Comp: Exporting a modified comp and skipping the option to render the
latest comp displayed a Track_Alpha.a is not a layer or channel name error message.

• BUG ID 252418 - Hiero only: Some Nuke Studio functions were enabled incorrectly in Hiero.

• BUG ID 262809 - Export: Shot templates containing multiple Write nodes did not append an index
number to the Write nodes, resulting in a Duplicate write node name error.

• BUG ID 263002 - Export: Copying and pasting multiple Write nodes into the shot template placed all
Writes vertically with overlapping connections in the resulting Nuke script.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes
• BUG ID 243563 - The knob.splitView() function changed incorrectly between Nuke 9 and Nuke 10
when passing a view in as an index (passing a string was unaffected). In Nuke 10, an index 0 referred
to the first view in a script, whereas in Nuke 9, an index of 1 referred to the first view. As a result, in
Nuke 10, knob.splitView() could create a value for an extra view that didn't exist. From Nuke 10.0v6
onward, knob.splitView() will behave the same as the Nuke 9 implementation.

The following Python functions are affected:

Array_Knob

setSingleValue(b, view) splitView(view) unsplitView(view)

setValue(value, index, time,
view)

setValueAt(value, time, index,
view)

value(index, view, time)

valueAt(time, index, view) setKeyAt(time, index, view) removeKey(index, view)

removeKeyAt(time, index,
view)

isKey(index, view) isKeyAt(time, index, view)

setAnimated(index, view) isAnimated(index, view) clearAnimated(index, view)

setExpression(expression,
channel=-1, view=None)

animations(view) animation(chan, view)

copyAnimation(channel,
curve, view)

copyAnimations(curves, view) splitView(view)

unsplitView(view)

Node

metadata(key, time, view)

RootNode

addView(name, color) deleteView(name) setView(name)
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Release Notes for Nuke and Hiero
10.5v1

Release Date
07 December 2016

Qualified Operating Systems
• Mac OS X 10.9 (Mavericks) or 10.10 (Yosemite)

• Windows 7 or Windows 8 (64-bit only)

• CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements. You need to have:

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 4.2 or above.

NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or
higher) is required.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which
can be downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

• an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5, running OS X 10.9.3
'Mavericks', or later.

Late 2013 andMid 2015Mac Pros Only

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5 (running
OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in
the preferences, GPU processing is shared between the available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1
and mid 2015 Mac Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for full
functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features

Blend Tracks

Nuke Studio's track blending feature now allows you to apply several new blend modes, as well as the
existing over blend. Additionally, a new masking feature has been implemented to limit the selected
blend function to only those areas covered by the image's alpha channel.

See https://youtu.be/DUTdW6CyDwM for more information.

You can still designate blend tracks using the right-click Editorialmenu, but track headers now
feature buttons to turn blending on and off without using the menu.

• Click the Blend icon to toggle blending on and off.

• Click and hold the Blend icon to select the blend mode.
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• Click theMask icon to toggle alpha masking on and off. TheMask feature limits the effect of the
blend to just those areas covered by the alpha channel in the blend image.

Create Comp

Nuke scripts created from the timeline now maintain concatenation, and are laid out more neatly.
The total number of nodes is also reduced as we have removed Constant and Copy nodes, and
swapped the FrameRange and AppendClip nodes for TimeClip and Merge nodes.

See https://youtu.be/W8uFhsvtaug for more information.

Export

• Nuke Studio's Export dialog has been re-arranged for clarity and ease of use. The core functionality
is unchanged, but the new layout improves visibility and uses the available space more efficiently.

See https://youtu.be/AGUDo1sCUCw for more information.

• BUG ID 234898 - Export: Loading a project from an earlier version of Nuke Studio displays a
warning, suggesting you save a new version of the project before continuing.
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NOTE: The new version is not compatible with earlier versions of Nuke Studio.

• 153233 - Versioning: Writing a new version of a clip instance now creates a corresponding new
folder in the export path, if the folder doesn't already exist.

Format and Resolution Improvements

Working with multiple formats and resolutions is now much easier. Now you can easily change the
resolution format of your timeline and maintain any transforms or crop soft effects to match the new
timeline resolution.

We have also changed the options for the interpretation of clip instances on the timeline to be more
intuitive, using the timeline Properties panel, which defaults to None, maintaining the timeline
resolution. These options also carry over to the Export dialog where you can decide at what
resolution you want to render your comps.

See https://youtu.be/DgRxgKQvbsQ for more information.

RayRender

• BUG ID 233034 - A new Transmission shader has been added, found under 3D > Shader, which
adds support for transparent shadows.

Feature Enhancements
• BUG ID 152134 - Write: Rendering now creates the necessary directories as specified in the Write
node's file control, if they don't exist.

• BUG ID 153528 - Nuke, Nuke Studio, and Hiero now support Apple ProRes 4444 XQ encoding.

• BUG ID 177736 - Export: The Export dialog now includes the do not attach prefix option for .exr
files.

• BUG ID 177737 - Export: The Export dialog now includes the interleave option for .exr files.

• BUG ID 198597 - Timeline: Nuke Studio now includes reformatting controls for clip instances on the
timeline in the Properties tab. You can also set the behavior for new clip instances at Project
Settings level and Preferences level. The Project Settings determine how clips are formatted in
new sequences, and the Preferences determine how clips are formatted in new projects.

• BUG ID 215257 - Channels: Nuke now sorts the RGBA layer first by default. To process channels
using the legacy method, set the NUKE_LEGACY_CHANNEL_SORTING environment variable.

• BUG ID 239202 - Export: You can now define which Write node in your export structure you want to
use as your main output for the timeline using the Contentmenu > Timeline Write Node
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dropdown. The Write node selected is connected to the Viewer in the resulting script and is also
used to render any comp containers in the sequence.

Bug Fixes
• BUG ID 140401 - Roto: Enabling downrez caused B-spline points to jump to the lower-left corner of
the Viewer when the Roto node was disconnected.

• BUG ID 144541 - Roto: Drawing/editing a spline in downrez mode, with the Roto node disconnected
from the Viewer, produced unexpected results.

• BUG ID 150101 - Gizmos/Groups: Enabling downrez caused handles to jump to the lower-left
corner of the Viewer.

• BUG ID 150935 - Export: Shot exports did not apply clip instance reformat size changes by default.

• BUG ID 151049 - Versioning: Selecting Version > Version Up/Down on an empty sequence caused
Nuke Studio to crash.

• BUG ID 151907 - RotoPaint: Drawing or editing a spline in downrezmode when the RotoPaint node
was not connected directly to a Viewer, produced unexpected results.

• BUG ID 152695 - Monitor Output: 8-bit and 10-bit color conversion was sometimes inaccurate,
causing a slight color shift.

• BUG ID 154342 - ModifyMetaData: Adding a ModifyMetaData node to the node tree broke
concatenation.

• BUG ID 155479 - Export: The {projectroot} token added // (forward slashes) to the path when
chosen from the file browser.

• BUG ID 161910 - Windows only: Rendering .mov files from the timeline was very slow in projects
with multiple cuts.

• BUG ID 162519 - mov64: The first frame of files containing themoov atom were not read correctly.

• BUG ID 162892 - QuickTime: Certain files written with both the mov32 and mov64 writers appeared
offset by 20 frames when compared.

• BUG ID 162950 - Playback speed occasionally dropped significantly, jumping to an un-cached region
of the timeline.

• BUG ID 163120 - Export: Tags were added to exported clips when they were added to the render
queue, rather than when the export was completed successfully.

• BUG ID 172943 - Deep: Changing a DeepExpression while the node was attached to a Viewer caused
Nuke to crash.

• BUG ID 176330 - Blend Tracks: Tracks in Viewer buffer B were not blended as expected.

• BUG ID 185405 - OCIO: Closing a comp using File > Close Comp discarded any OCIO config settings
that were applied in the Project Settings.

• BUG ID 194899 - Export: The DWAA/DWAB compression controls were not displayed correctly.
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• BUG ID 196651 - QuickTime: Reading .mov files containing annotation (not those created by Nuke
Studio exports) caused Nuke to crash.

• BUG ID 201436 - Export: Nuke Studio added an extra / (forward slash) in export paths specified
using the Choose button.

• BUG ID 202140 - Adding a ModifyMetadata node occasionally caused unexpected cropping in the
compositing Viewer.

• BUG ID 207336 - Python: Opening a sequence created through Python in the Script Editor caused
Nuke Studio to crash.

• BUG ID 215394 - Export: Using the {ext} token to create or save an export structure for two exports
of different formats in the same folder with same name did not work as expected.

• BUG ID 216023 - Windows only: Using the root of a drive for the {projectroot} variable was ignored
for Create Comp operations.

• BUG ID 217362 - Write: Setting the file type control tomov did not enable the Advanced controls
for the default Apple ProRes 4444 codec.

• BUG ID 228379 - Monitor Output: Video mode limited colors in RGB space, rather than in the
expected colorspace.

• BUG ID 229556 - RayRender: Rebuilding AOVs from beauty passes did not match the rgba output of
RayRender.

• BUG ID 229597 - RayRender: Color information was missing from the direct diffuse AOV.

• BUG ID 229734 - Monitor Output: 12-bit output was incorrect with some cards.

• BUG ID 230994 - Text: Adjusting a transform Pythonically caused Nuke to crash.

• BUG ID 231019 - Timeline: Playback was muted incorrectly if mute was active when playback
stopped previously.

• BUG ID 231443 - ModifyMetaData: Groups containing ModifyMetaData nodes caused Nuke to crash
on exit.

• BUG ID 232553 - Timeline Viewer: Certain rows of pixels were not decoded correctly for some .tiff
files.

• BUG ID 233744 - Monitor Output: The selected output resolution changed when playback started.

• BUG ID 233797 - Create Comp: Non-blended track items with a Fade In transition applied, faded
from the track below, rather than from black.

• BUG ID 234744 - Blend Tracks: The default track header size was too small to contain the new blend
buttons and the track name.

• BUG ID 235451 - Linux only: Themov32 encoding not available on Linux warning appeared too
often when creating .mov export presets.

• BUG ID 235545 - Create Comp: Track-level soft effects did not include Backdrop nodes in the comp.

• BUG ID 235583 - Create Comp: Not all nodes associated with a disabled track item were disabled in
the resulting comp.
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• BUG ID 235693 - TimeClip: Values of 1 for the frame rangelast or original rangelast controls were
reset to 100 when a script was reloaded.

• BUG ID 239079 - Create Comp: Scrubbing the playhead on comps containing retimed blend tracks
caused Nuke Studio to crash.

• BUG ID 239212 - Export: Some Process as Clips export presets were merged together in the Export
dialog.

• BUG ID 239291 - Soft Effects: Loading a legacy project that employed the deprecated Flip, Flop, or
Turn options added multiple copies of soft effects, when the project was saved and then loaded in
Nuke Studio 10.5.

• BUG ID 239295 - RayRender: Adding motion blur when using the AmbientOcclusion shader
produced wireframe artifacts on the geometry.

• BUG ID 239341 - Create Comp: Disabled clip instances or tracks occasionally caused Create Comp
to fail.

• BUG ID 239383 - QuickTime: The mov32 encoder did not present the correct timestamp for repeated
frames when compared to mov64.

• BUG ID 239493 - Create Comp Special: Using theMotion retime method in the Export dialog
produced incorrect results when compared to earlier versions of Nuke Studio.

• BUG ID 239964 - Export: The Preview file path under the shot template did not resolve folder paths,
only file paths.

• BUG ID 241290 - Create Comp: Creating a comp with no Write node selected in the Export dialog
failed, displaying an unclear error message.

• BUG ID 241297 - HieroPlayer: Left- or right-clicking on a track header caused HieroPlayer to crash.

• BUG ID 241492 - Create Comp: Metadata nodes in disconnected soft effect track layouts were
connected to nodes in the previous track.

• BUG ID 241525 - Export: Enabling Collate Shot Name duplicated soft effects on the collated clip
instance.

• BUG ID 241829 - Create Comp: Comps containing retimes were offset by one frame.

• BUG ID 241932 - Timeline: Attempting to delete empty spaces on the timeline caused Nuke Studio to
crash.

• BUG ID 242111 - Mac OS X only: Adding dissolves to blended tracks occasionally dropped frames
during the transition.

• BUG ID 242281 - Create Comp: Projects containing duplicated tracks or tracks with the same name
displayed errors when creating comps.

• BUG ID 242521 - Create Comp: Adding multiple Transform effects to tracks in a comp did not fill the
format correctly, resulting in lower tracks being visible in the comp.

• BUG ID 242895 - Localization did not work for clips with multiple versions.

• BUG ID 243335 - Export: Footage was rendered black when rendering with Apple ProRes (HQ, LT,
PROXY) and several other codecs.
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• BUG ID 243442 - Create Comp: The Burn-in effect occasionally displayed incorrect values for
hiero/clip and input/frame.

• BUG ID 245022 - Mac OS X only: When building a track, all exported clips were separated rather than
being compiled together, and only one track was created.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes

There are no bug fixes in this release.
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